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Abstract
This template was done to help you ease your work of redacting your thesis.  It has easy tools such as adding an equation (with Copy/Paste) and it automatically updates the equation numbers not just next to the equation but also whenever it is reference. The same goes for Figure numbers within captions and within paragraphs. It can save you a lot of time and helps you have a more professional thesis with least amount of mistakes. 
The template also shows you how to have Table of Contents updated in a second! (with a mere Right-click and Update fields>Update Entire Table and/or Numbers Only) This is particularly important the last few days before deadline for submitting your thesis after applying changes suggested by your committee members. 
Remember to use Help on the Word® Menu if you have questions. Also it is suggested that the thesis is written in English to reach a wider audience. Remember that sentences in English are much shorter than in Spanish so do not try to translate directly. You can use the editing services at UPRM. Choose Tools>Language>English(US or UK).
The same goes for equations. To enter a new equation, or Figure/Table caption, copy any one already in the document and paste it.  Then edit the equation. The equation/ figure/ Table number when updated, will have the correct chapter number and the correct equation/fig/table number. To refer or mention a particular figure in your text, do Insert>Cross-Reference and on “Reference Type”: choose Figure, Table, or Equation. Then on “Insert Reference to:” chose only Label and Number.  
To update ALL fields within the document do Control-A(or Command-A for mac), then Right-Click and Update.
*Do NOT expect the text in this thesis example to make sense since it was trimmed from a 200+pages to fewer pages just to serve as example. In addition, many references where removed (References can be done with cross-reference tool, but that is beyond our scope in this template). We wish you success!

RESUMEN

El resumen debe ser la traducción exacta del Summary.  Select this section with the mouse, and choose Tools>Language> Spanish> for this section only.











Bla blab la abla abla abal abla,
 Bla abla abla 
Bla bla abla abla  
[bookmark: _Toc100036846]











Acknowledgements

Blabla bla abla abla abla

[bookmark: _Toc100036847]Table of Contents


1	CHAPTER –INTRODUCTION	1
2	CHAPTER- LITERATURE REVIEW	3
2.1	Stochastic Modeling and Short-Term Rainfall Forecasting	3
2.2	Radar Rainfall Estimation and Validation	7
3	CHAPTER – METHODOLOGY	1
3.1	Study Area	2
3.2	High Resolution Rainfall Radar Product	4
3.3	TropiNet radars	6
3.3.1	Radar Data Processing TropiNet	8
3.3.2	Calibration Performance	8
3.4	Inundation Model	8
3.4.1	Precipitation Estimation	10
3.4.2	Variables Initials and optimization	12
3.4.2.1	Least Square Method	15
3.4.2.2	Kriging Interpolation	15
3.4.3	Events selection	17
3.5	Hydrologic Model Composition	18
4	CHAPTER - RESULTS	1
4.1	Data Acquisition	1
4.2	Rain gauges-TropiNet – NEXRAD comparison	2
4.3	Nowcasting Model Movement and Reflectivity Analysis	5
4.4	Parameters Estimation	6
5	CHAPTER - CONCLUSION	9
References	10
[bookmark: _Toc100036848]
List of Tables

Table 3‑1. Radar bands with frequencies and wavelength [Rinehart, 1997])	6
Table 3‑2. Characteristics of Studied Storm.	18
Table 3‑3. Drainage area peak discharge relationship [FEMA, 2012].	19
Table 4‑1. Detection results for ten storms with lead-time of 10 minutes.	8
Table 4‑2. Detection results for ten storms with lead-time of 20 minutes.	8
[bookmark: _Toc100036849]
List of Figures

Figure 2‑1. Flowchart Stochastic Model based [Box and Jenkins, 1976]	4
Figure 2‑2. Forecast 1h and 2h ahead of hourly rainfall intensity and accumulative rainfall using event-based approaches for the event of 18 February 1953, Denver station, Colorado, USA [Burlando et al., 1993].	5
Figure 2‑3. Long range problem with NEXRAD (based on Cruz-Pol et al., 2011). The figure does not include topography of the land surface.	9
Figure 3‑1. Digital Elevation Model.	3
Figure 3‑2.TropiNet-2 at Lajas.	5
Figure 4‑1. Comparison TropiNet and NEXRAD on May 06, 2014- 17:42.	3
Figure 4‑2 . Comparison Rain Gauge-NEXRAD-Average	4
Figure 4‑3. Phi median, storm date: March 28, 2012, lead-time of 20 min.	7
Figure 4‑4. Distribution of initial value of phi (left) and the optimal values of phi (right) for the storm date: March 28, 2012,for a lead-time of 30 min.	7

[bookmark: _Toc330203718]
GLOSSARY OF TERMS

A		flow area
a, b		coefficients in the radar rain rate equation
AMS		Annual Maximum Series
ArcGIS	Arc Geographical Information Systems
ASCII		data file in text format
Bias		bias
C		Celsius
CASA		Collaborative Adaptive Sensing of the Atmosphere
DB		discrete bias
dBZ		decibels
DEM		digital elevation map
DHSVM	Distributed Hydrology Soils and Vegetation Model
ea		actual vapor pressure
es		saturated vapor pressure
ET		evapotranspiration
ETo 		reference evapotranspiration
HEC		Hydrologic Engineering Center
HEC-RAS	Hydrologic Engineering Center-River Analysis System
kPa		kilopascal
NAD		North American Datum
N1P		precipitation radar product
NEXRAD	Next Generation Radar
Ni		adjustment factor
NOAA		National Oceanic and Atmospheric Administration
O 		model output with input parameters set at base values

  are model outputs with the input parameter plus or minus a specified 
Percentage
R2		Pearson correlation coefficient or coefficient of determination
Ra		extraterrestrial radiation
RMSE		root mean squared error
SSURGO	refers to the Soil Survey Geographic Database |
STD		standard deviation
t		time
TARS		Tropical Agriculture Research Station
Tave	 	average air temperature
TBSW		Testbed Subwatershed
TM		Thermatic Mapper
Tmax		maximum air temperature
Tmin		minimum air temperature
TRMM	Tropical Rainfall Measuring Mission


[bookmark: _Toc274203613]CHAPTER –INTRODUCTION

Portions of Puerto Rico Western area are subject to flash flooding due to sudden, extreme rainfall events, some of which fail to be detected by NEXRAD radar located 104 km away in the town of Cayey, Puerto Rico and partially obstructed by topographic features. The use of new radars with higher spatial resolution and covering areas missed by the NEXRAD radar, are important for flood forecasting efforts, and for studying and predicting atmospheric phenomena. 
Recently, the University of Puerto Rico in Mayagüez Campus, Trabal et al., [2011] initiated investigations using two (2) types of radars, namely: Off-the Grid (OTG) and TropiNet, with radius of coverage of 15 km and 40 km, respectively. This network will monitor the lower atmosphere where the principal atmospheric phenomena occur.  This work represents the first time that TropiNet radar technology will be used for hydrologic analyses and specifically for rainfall forecasting in Puerto Rico western area. 
Short-term rainfall forecasts have commonly been made using Quantitative Precipitation Forecast (QPF).  The introduction of quantitative precipitation forecasting (QPF) in flood warning systems has been recognized to play a fundamental role, QPF is not an easy task, rainfall being one of the most difficult elements of the hydrological cycle to forecast [French et al., 1992] and great uncertainties still affect the performances of stochastic and deterministic rainfall prediction models [Toth et al., 2000].
This capability currently does not exist in Puerto Rico Western area, and is needed because of the potential for flooding in certain areas (e.g., in flood plains near the principal rivers).   In this research, short-term rainfall forecast analysis performed using non linear stochastic methods. Once obtained, the rainfall forecast is introduced into a hydrologic/inundation model Vflo and Inundation Animator configured for the Vflo Bay Drainage Basin (MBDB).  

Specific components of the research are: the inclusion of calibration and validation of rainfall estimates produced by the TropiNet radar network, the development and validation of the stochastic rainfall prediction methodology, the calibration and validation of the inundation algorithm at selected locations within the MBDB, and the proto-type of an operational, real-time flood alarm system for the MBDB.  The proto-type, automated flood alarm system will send near-real time updated inundation images to a website on the Internet.

 This research consists of a review of the scientific literature in Chapter 2, justification for the research in Chapter 3, objectives in Chapter 4, and the methodologies for the research are given in Chapter 5.  The results are provided in Chapter 6.  



[bookmark: _Toc274203614]CHAPTER- LITERATURE REVIEW

In this section we will provide a brief review of the literature related to each of the components of the proposed project.  These components include:  stochastic modeling and short-term rainfall forecasting, radar rainfall estimation and validation, hydrologic/inundation modeling and real-time flood forecast systems.

[bookmark: _Toc274203615]Stochastic Modeling and Short-Term Rainfall Forecasting  

There are many approaches that can be used to predict the future direction and magnitude of a physical process, such as rainfall.  Forecasting is a large and varied field having two predominant branches: Qualitative Forecasting and Quantitative Forecasting [Hyndman, 2010].  Quantitative Forecasting should satisfy two conditions, the accessible numerical information about the past and assumptions that some aspects of the past patterns will continue into the future. Quantitative Forecast can be divided into two classes: time series and explanatory models. Explanatory models assume that the variables to be forecast exhibits an explanatory relationship with one or more other variables, in contrast, time series forecasting uses only information on the variable to be forecast, and makes no attempt to discover the factors affecting its behavior [Hyndman, 2010]. The time series models attempt to capture past trends and extrapolate them into the future. There are many different time series models but the basic procedure is the same for all as illustrated in Figure 2‑1. 
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[bookmark: _Ref399426130][bookmark: _Toc397772542][bookmark: _Toc397772894][bookmark: _Toc397773088][bookmark: _Toc274203239]Figure 2‑1. Flowchart Stochastic Model based [Box and Jenkins, 1976]

Some of the most common time series methods include: Autoregressive, Moving Average, Exponential Smoothing, Autoregressive Moving Average, Extrapolation, Linear Prediction and others [Box and Jenkins, 1976], this research include a new type of time series non linear with a stochastic and deterministic components, this will be explained later.
The autoregressive (AR) method is a type of random process, which is used to predict some types of natural phenomena, falling within the group of linear prediction formulas. The moving average (MA) method is a way to convert actual observations to forecast by simply averaging [Box and Jenkins, 1976]. Exponential smoothing is a popular scheme to produce a smoothed time series; exponential smoothing assigns exponentially decreasing weights to the observations as they get older. That is to say recent observations are given relatively more weight in forecasting than the older observations. With the Autoregressive Moving Average (ARMA) method, models are used to describe stationary time series, which represent the combination of an autoregressive (AR) model and moving average (MA) model.  The order of the ARMA model in discrete time () is described by two integers (p, q), that are the orders of the AR and MA parts, respectively.  A process is considered to be stationary when parameters, such as the mean and variance, do not change over time or maintain the same range. Autoregressive (AR) or Autoregressive moving average (ARMA) are models widely used in the prediction.  Other time series methods include extrapolation and linear prediction, non linear prediction with exponential component, depending of data behavior.
[bookmark: _Toc346179118][bookmark: _Toc397772543][bookmark: _Toc397772895][bookmark: _Toc397773089][image: ]
[bookmark: _Ref399426131][bookmark: _Toc274203240]Figure 2‑2. Forecast 1h and 2h ahead of hourly rainfall intensity and accumulative rainfall using event-based approaches for the event of 18 February 1953, Denver station, Colorado, USA [Burlando et al., 1993].


Burlando et al., [1993] assumed that the rainfall processes are typically non-stationary and skewed.  To circumvent non-stationary, the rainfall data are grouped by month of season; thus the model is applied separately for data of a given month or a given season.  Accordingly, model parameters such as autoregressive and moving average coefficients were determined from precipitation data pertaining to a given month or season only. 
Parameter estimation of ARMA models based on short-term precipitation records defined at hourly time-scales is more complex than when data is defined at longer time periods such as months.  The main reason is the intermittent characteristic of hourly precipitation. 
A popular decision rule for comparing models in the time series literature is the Akaike Information Criterion (AIC) [Akaike, 1974]. This criterion is known as the test for the 
The maximum likelihood estimation criterion is suited for the selection of a model for simulation purpose. For short-term forecasting, such as one step ahead forecasting, the mean square error (MSE) criterion may be more useful [Kashyap and Rao, 1976].

Selection of a model based on an MSE criterion is quite simple and can be summarized as follows: 
1. Estimate the parameters of different models using a portion, usually half of the available data. 
2. Forecast the second half of the series one step ahead by using the candidate models. 
3. Estimate the MSE corresponding to each model and 
4. Select the model that results in the least value of the MSE. 
Other examples of rainfall forecasting models were developed. PRAISE (Prediction of Rainfall Amount Inside Storm Events) is a stochastic model to forecast rainfall height at site. PRAISE is based on the assumption that the rainfall height accumulated on a delta time is correlated with a variable that representing antecedent precipitation. The mathematical background is given by a joined probability density function and by a bivariate probability distribution, referred to the random variable, represents rainfall in a generic site and antecedent precipitation in the same site. The peculiarity of PRAISE is the availability of the probabilistic distribution of rainfall heights for the forecasting hours, conditioned by the values of observed precipitation. PRAISE was applied to all the telemetering rain gauges of the Calabria region, in Southern Italy; the calibration model shows that the hourly rainfall series present a constant value of memory equal to 8 hours, for every rain gauge of the Calabria network. As a study area the Calabria region in southern Italy was selected to test performances of the PRAISE model [Sirangelo et al., 2007].

[bookmark: _Toc346179088][bookmark: _Toc274203616]Radar Rainfall Estimation and Validation


The National Weather Service is in charge of providing weather, hydrology, and climate forecasts and warnings for the United States including Puerto Rico and U.S Virgin islands, working with a network of 159 high resolutions Doppler weather radars, commonly referred to as NEXRAD (NEXRAD or Next-Generation Radar). The technical name for NEXRAD is WSR-88D, which stands for Weather Surveillance Radar, 1988, Doppler (National Climatic Data Center, 2012). NEXRAD detects precipitation and atmospheric movement or wind.  The NEXRAD radars can provide information that can help mitigate disasters caused by flash floods.  Errors can occur with the methodology for observations far from the radar, where the earth’s curvature limits the observation of the lower atmosphere, see Figure 2‑3.  NEXRAD coverage has limitations in observing below 10,000 feet or 3 kilometers (called the Gap) above sea level for the Mayagüez area and nearby towns [Cruz-Pol et al., 2011].  At these locations, NEXRAD cannot “see” if raindrops are forming within the Gap, resulting in a different rain rate than other radars which can measure the lower portion of the cloud (OTG and TropiNet).  In the OTG and TropiNet radars, the rain rate equations can be selected, whereas NEXRAD rain rate uses the tropical equation with a threshold reflectivity (Z) of 53dBz, Z values above 53 dBz are assumed to be hail and are not considered. Other difference between NEXRAD and TropiNet radar is that NEXRAD has Doppler capabilities given information on cloud motion, and TropiNet has Polarimetric capabilities which give information on precipitation type and rate. Polarimetric radars refer to dual polarization radars which transmit waves that have horizontal and vertical orientations. The horizontal wave provides a measure of horizontal dimension of the cloud and rainfall and the vertical wave provides a measure of particle size, shape and density.

[image: C:\Users\Eric Harmsen\Documents\TESIS\propuesta\figuras\figura-radar.png]
[bookmark: _Ref399426529][bookmark: _Toc346179119][bookmark: _Toc397772544][bookmark: _Toc397772896][bookmark: _Toc397773090][bookmark: _Toc274203241]Figure 2‑3. Long range problem with NEXRAD (based on Cruz-Pol et al., 2011). The figure does not include topography of the land surface.

The use of the new radars OTG and TropiNet with higher spatial resolution and their observations of the lower atmosphere in the Western Puerto Rico area provide better atmospheric information in the lower zone because curvature effect is minimal, at minimum elevation.


[bookmark: _Toc274203617]CHAPTER – METHODOLOGY

The University of Puerto Rico at Mayagüez has a radar research network and a rain gauge network developed for this thesis. The radars network provide information with higher spatial and temporal precision, TropiNet has resolution spatial of 60x60 meter every pixel and temporal resolution of 1 minute.  A flood warning model must be operated based only on the data available at the time of forecast. Only the radar can display data in real time, this is not possible using rain gauges. Rain gauges based systems must have a dependable and redundant telemetry system that will accurately and efficiently transmit data a central location for processing. 
The Data from TropiNet radar was used for rainfall prediction in MBDB, using stochastic methods. Once the rainfall forecast is obtained, the use of hydrologic models is necessary for analysis of flooding in this area.
This chapter present a general overview of the methodology utilized in this investigation, this is the first attempt to implement news technology to the performance of flood alert/warning systems. This research is center in the Puerto Rico western area and could be applied in general to other areas or regions with the same rainfall type. 




[bookmark: _Toc346179094][bookmark: _Toc274203618]Study Area


The study area, which encompasses the MBDB, is 819.1 km2 in area [Rojas, 2012 and Prieto, 2007] and is located in western Puerto Rico.  The watershed also has three (3) important water bodies: Rio Grande de Añasco, Río Guanajibo and Río Yagüez. The area includes twelve (12) municipalities: Mayagüez , Añasco, Las Marías, San Sebastián, Lares, Maricao, Yauco, Adjuntas, Sabana Grande, San Germán, Hormigueros and a part of Cabo Rojo. 
The Río Grande de Añasco originates near the Cordillera Central, flows west and discharges into the Bahia de Añasco, the alluvial valley covers an area of approximately 46.62 km2. It is bounded by hills to the north, east and south and by the Bahia de Añasco to the west. The tributaries of the river Añasco that flow into the lower valley are the Rio Dagüey and the Rio Cañas.  The basin is located in west-central Puerto Rico, in the municipalities of Añasco, Lares, Las Marias, Maricao, Mayagüez  and San Sebastián. Changes in elevation are shown and vary from zero meters at mean sea level in the coastal areas to 960 meters in the mountainous areas, see Figure 3‑1.  According to U.S Environmental Protection Agency, the upper reaches of the basin contain four connected reservoirs; the lago Toro, Lago Prieto, Lago Guayo and Lago Yahuecas, to the Añasco watershed downstream of the lakes which is not significant for regional water budget estimation [Prieto, 2007]. The total lake drainage area is about 116.55 km2 and was used as a boundary condition in the model. 

[image: C:\Users\Eric Harmsen\Desktop\presentaciones-ppt\Elevation.png]
[bookmark: _Ref399428712][bookmark: _Toc274203242]Figure 3‑1. Digital Elevation Model.

According to Flood Insurance Study by Federal Emergency Management Agency [FEMA, 2012] the land use on the Río Grande de Añasco watershed are distributed as follows: 278 km2 are cropland; 114 km2 are pasture; 85km2 are forest and woodland; 33 km2 are idle, and 13 km2 are urban development and other uses. The vegetation in the floodplain is primary sugar cane. Soils in the floodplain are clay loams (Unpublished Soil Borings in Añasco Basin). 

Flood problems in this study area are serious and widespread. Periodic flood damage to sugar cane, pastureland, roads, and a number of residential areas is significant. Flood waters have inundated the main Río Grande de Añasco floodplain 17 times in a period of 31 years, an average of approximately once every 2 years. 


[bookmark: _Toc346179095][bookmark: _Toc274203619]High Resolution Rainfall Radar Product


Commonly, the flood alert systems have fulfilled the role of providing flood notification to many people and have saved lives and properties. However, many alert systems fail due to low precision of the models and the sudden change of the atmosphere.  One of the greatest sources of uncertainties in the prediction of flooding is the rainfall input [Rojas, 2012].  It is therefore essential to have an accurate source of rainfall data, and this is only possible with properly working radars. 
The National Weather Service has a network of 160 Doppler-radar stations S-band (10-cm wavelength) radar distributed across the continental United States, Alaska, Hawaii, Guam and Puerto Rico. This network was originally designed to support Departments of Defense, Transportation and Commerce objectives for detection and mitigation of severe weather events [Warner et al. 2000]. Digital distributed-precipitation radar products can be downloaded directly from the National Weather Service (NWS).
 
The NEXRAD (Next-Generation-Radar) located in Cayey measures reflectivity to 1 km by 1 degree resolution to a diameter (distance) of 460-km.
Figure 3‑2 shows the TropiNet radar at Lajas. A new TropiNet radar is being installed at the UPR Agricultural Experiment Station in Isabela, which has the same characteristics as the other two. When the three TropiNet radars are operating simultaneously the cover area will be approximately half of the island.


[image: ]
[bookmark: _Ref399447354][bookmark: _Toc274203243]Figure 3‑2.TropiNet-2 at Lajas.
 The OTG radars were developed with a heterogeneous network using off the shelf hardware. The network was designed to provide detailed precipitation estimates (QPE) to the public, including the (NWS) National Weather Service staff in Puerto Rico.  Coincidentally, on the opening day of the Central American Games “Mayagüez 2010”, NEXRAD was offline and missed a large rainfall event which occurred in the Mayagüez area, but the “Weather Radar Network of Puerto Rico” radars were functioning and were able to record the event.

[bookmark: _Toc274203620]TropiNet radars


Radars are an active sensor that emits electromagnetic pulses into the surroundings. A typical radar system consists of a least four components: [Rinehart, 1997]. Lower frequency and higher wavelength suggest that the radar has robust signal power and less attenuation, the weather radar system discussed in this thesis is based in X-band. The common weather radar system can be classified as listed in Table 3‑1.

[bookmark: _Ref399447591][bookmark: _Toc274202574]Table 3‑1. Radar bands with frequencies and wavelength [Rinehart, 1997])
	Radar Band
	Frequency
	Wavelength

	L
	1-2 GHz
	30-15 cm

	S
	2-4 GHz
	15-8 cm

	C
	4-8 GHz
	8-4 cm

	X
	8-2 GHz
	4-2.5 cm

	KU
	12-18 GHz
	2.5-1.7 cm

	K
	18-27 GHz
	1.7-1.2 cm

	Ka
	27-40 GHz
	1.2-0.75 cm

	W
	40-300 GHz
	0.75-0.01 cm



The TropiNet (RXM-25) radars are Doppler polarimetric radars which allow the radar beam to measure reflectivity close to the ground, overcoming the shadow effect of the Earth’s curvature, while maintaining high range and azimuth.  The first of three proposed radars has been developed and it is in operation since February 2012, TropiNet 1 is located in “Cerro Cornelia” Cabo Rojo, Puerto Rico 18.16°N, 67.17°W, and 200 ft elevation (msl) approximately. The radars, working with the X-band frequency, are about three times stronger than that of the traditional radar frequencies at S-band making the measurements of rainfall more attractive. They have high space and time resolution for weather monitoring and detection, and are capable of generating very high resolution data with a range of 40 km or maximum radial distance (horizontal range) of 80 km. 

NOAA-NWS [1995] report recommended that Z-R relationship in use at the time of the event be changed from  to a relationship more representative of raindrop distributions in a warm tropical storm. The Z-R relationship for warm tropical events recommended by OSF since 1995 for all WSR-88D sites experiencing heavy rainfalls, and now adopted by TropiNet is  . The Z-R relationship used in Puerto Rico is the convective, also was necessary to define a maximum precipitation rate threshold for decibels above 53 dBz [Vieux and Bedient, 1998]. The convective rainfall is a type of precipitation with some characteristics like very high horizontal gradient and very large vertical depths, these characteristics means that the weather radar is the best tool for detecting convective precipitation, but the presence of different types of hydrometeors, especially hail and storm dynamics resulting in fast varying Vertical Profile Reflectivity (VPR) usually result in considerable random error in quantitative precipitation estimates. Large differences can be found especially when comparing rain gauges and radar estimates because of the high temporal and spatial variability of the convective storm and related vertical profile of reflectivity [Rossa et al., 2005].

[bookmark: _Toc274203621]Radar Data Processing TropiNet 

A radar application in MatLab was developed to access the store of binary volume files that contain the respective information as determined by the operator like reflectivity, azimuth, velocity, beam width, range, elevation and other radar products. The operator can apply any possible scan forms Range Height Indicator (RHI).

[bookmark: _Toc274203622]Calibration Performance

There is a sequence called the “Ordered Physics Based Parameters Adjustment” (OPPA) method developed by Vieux and Moreda [2003]. The calibration process (OPPA) approach include estimates of the spatially distributed parameters from physical properties, assigns channel hydraulic properties based on measured cross-sections where available, studies model sensitivity for the particular watershed, and identifies response sensitivity to each parameter. 

[bookmark: _Toc346179099][bookmark: _Toc274203623]Inundation Model


The Inundation Analyst is a Vflo [Vieux et al., 2002] extension that provides images, animations and simulated inundation, which is an indication of flood risk. The extension is especially useful for flood management applications; for example, a forecast inundation is useful for operational decisions, warning and notification, and coordinating emergency response.  The Inundation Analyst operates independently from the Vflo model, but can use data exported from Vflo  as input for generating inundation forecasts. The Inundation Analyst requires a digital elevation model (DEM), a flow direction map, a channel flow direction map, and stage data. All input data must be in ESRI ASCII grid format (*.asc). 
All input data are ASCII and the flow direction is extracted from the DEM watershed. The DEM have units of meters, the stage data input are exported from Vflo model, a background watershed image is included in bitmap format. The inundation results are listed in order to create the animation, once all stage files are listed in the appropriate order the images that are produced show the primary inundation Analyst window. 
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To determine the centroid of the cells it is necessary to calculate latitude  and longitude   of every pixel group.
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Dixon and Wiener [1993] found that a convective cell have a mean velocity of 64km/hr, this value agrees with the velocity cell measure from other research, for this model a velocity mean of 72 km/hr approximately or 12km/10minutes was used, to apply this a maximum distance between cloud at every lag time of 200 pixels was necessary, if the analysis is every 10 minutes, if this analysis time increase, then the distance could increase.


[bookmark: _Toc274203624]	Precipitation Estimation

The precipitation estimation is based in the main equation applied to each zone in every window. The rain estimated  at time ( is the result of the prediction interval  between the instants   and  correlated with the variables that are change in the 8,528 zones, these variables were determined in each zone (9x9) using optimization techniques for nonlinear regression. The main equation includes three (3) fundamental products:   these are the average observed rain at time  and time , the average is calculated between the eight (8) nearest pixel to the prediction pixel, the other  is the value of the rain at ,  and the    is the ratio of reflectivity at ().

The main equation has some restrictions in the variables  that are changing in time and space. The clouds are in movement and the values of the variables are changing continuously. After the optimization, the deltas values are restricted to be positive or equal to zero.

	
	
	(3‑6)



The variables of  are the minimum and maximum reflectivity value respectively between the last two (2) windows at  and at the zone (9x9), these variables are changing in time and space (every zone 9x9). Moreover the variable  changes in every zone and windows but having a restriction limit of 1.1 in the optimization routine.
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Once the variables were found the next step was to estimate the rain rate forecast in every pixel. Pixels that were not possible to do the estimation prediction or there is not enough data at time  and/or at time , the “Kriging” interpolation method was used to estimate the rain pixel to derive the corresponding predictors [Wackernagel, 2003]. 

[bookmark: _Toc274203625]	Variables Initials and optimization

The variables into the nonlinear equation model are fundamental in the precipitation forecast trend. A well-planned approach is needed to properly solve the nonlinear constrained problem. The explored approach includes two steps: (i) Identifying the initial point and (ii) Using a constrained nonlinear optimization technique to estimate the final parameter set for each zone and every window.
To estimate the initial values of deltas, it was not necessary to apply a constrain, so that the initial deltas values can be positives or negatives. The main equation was linearized taking known values of  and  and the unknown values of  , left the parameter phi  temporarily ignored.
This method consists in solving the equivalent linear model and using these values as the initial point.  The convergence of nonlinear routine heavily depends on the selections of the initial points. Thus, if the initial point is far away from the optimal solutions the algorithm may converge to a suboptimal point or may not converge. 
Linearizing and ignoring the phi variable:

	
	
	(3‑10)



where
	
	
	[bookmark: _Ref399586524](3‑11)



  is an unknown random variable at time  and at location  of the  zone, the initial values of delta are obtained by solving the linear regression by the least square method.
The phi parameter is a bias correction factor and can be estimated using a second linear regression.

	
	
+ 
	(3‑12)



where the condition in the Equation (3‑11) is present 
 is an unknown random variable at time  and at location  in the zone 9x9.
Simplifying with the initial delta estimates the following equation is obtained. 
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where
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 is an unknown random variable at time t and at location  of the  zone, ’s are the previous estimated or initial values of deltas.
The next step is the most important in this section, finding the optimum values of variables   and from initial values determined in the previous steps. The parameters of the nonlinear regression model can be easily estimated by solving a constrained nonlinear optimization problem. 
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Therefore, it can be solved by using the “sequential quadratic programming” algorithm [Reklaitis et al., 1983; MathWorks, 2011]. The derived initial point was ingested into the constrained nonlinear subroutine to facilitate convergence, the parameters of the exponential term were restricted to be positive, and the phi parameter was restricted to be in the range of 0 to 1.1 value, this threshold was derived by inspection. The optimization objective was minimizing the errors between the estimate values for the regression and the observed values by radar.

In these regions in the prediction where there are clouds (or cells) present in the movement estimation, but not the required minimum number of pixels, the pixels estimation predictions were obtained by Kriging interpolation.


[bookmark: _Toc274203626]Least Square Method

The least squares estimate of the multiples regression parameters were used to calculate the initial values of deltas variables. The multiple linear regression model is typically stated in the following form:

	
	
	(3‑18)



where the dependent variable is ,  are the regression coefficients and  is the random error assuming  and  for . 

[bookmark: _Toc274203627]Kriging Interpolation

Kriging is based on the assumption that the parameter being interpolated can be treated as a regionalized variable. A regionalized variable is intermediate between a truly random variable and a completely deterministic variable in that it varies in a continuous manner from one location to the next and therefore points that they are near each other and have a certain degree of spatial correlation, but points that are widely separated are statistically independent [Davis, 1986].  
The Kriging techniques are based on the estimation of weighting coefficients with an assumption of unbiased-ness. Each data has its own coefficient , which represent the influence of a particular data on the value of the final estimation at the select grid node. The relationship between the existing data and the estimation point has been expressed by variogram values or by covariance in case of second order stationarity. Such values describe the spatial dependence and the influence of the particular location in terms of its distance and direction from the estimated location [Malvic and Balic, 2009].
The basic equation used in ordinary Kriging is as follows:

	
	
	(3‑19)



where   is the number of scatter points in the set,   are the values of the scatter points, and   are the weights assigned to each scatter point.  The weights are found through the solution of the simultaneous equations: 
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where  is the model variogram evaluated at a distance equal to the distance between points and  . It is necessary that the weights sum to unity.

	
	
	(3‑21)




The Kriging techniques add some constraints to the matrices, to minimize the error, and these techniques are unbiased-ness estimations. These factors would describe some external limit on the input data, which cannot simply be observed in the measured values [Malvic and Balic, 2009]. 

[bookmark: _Toc274203628]     Events selection

To select the events it was necessary to analyzed every one storm during 2012 and 2014, the analysis has three (3) important steps: the first was taking every minute data from TropiNet radar and plot it, for this was necessary create an efficient routine in MatLab to determine that the radar data has not interruptions or damage, if instead the radar has corrupt data the storm is discard to be evaluated. In some cases it was found that the radar takes data in “Plan Position Indicator’ (PPI) and after the radar is changed to “Range High Indicator” (RHI), such data was also discarded. 
Table 3‑2 includes the dates and specifications of every storm to study, the information incorporate in the column “Storm Impact” was provided by National Weather Services (NWS) at Carolina, Puerto Rico (personal communication Carlos Ansemi). 

[bookmark: _Ref399598873][bookmark: _Toc274202575]Table 3‑2. Characteristics of Studied Storm.
	Date
	Duration
(UTC)
	Storm Type
	Storm Impacts

	May 21, 2014
	7 hr.
16:46-23:00

	Heavy convective storm
	The water covers the roadway. Ponding of water on roadways

	June 29, 2014
	5 hr.
17:00-22:00

	Convective storm
	The shower activity produced periods of moderate to locally downpours

	June 30, 2014
	4 hr.
16:00-20:15

	Thunderstorms associated to the leading edge of a tropical wave
	Moderate to heavy rain, urban and small stream flood advisory

	July 05, 2014
	4 hr.
16:44-20:00

	Convective storm
	Heavy rain, urban flood.




[bookmark: _Toc274203629]  Hydrologic Model Composition


The hydrological Model used in this research was Vflo, this model use finite elements that can simulate streamflow based on geospatial data to simulate interior locations in the drainage network and determine channel flow and overland flow, it was fundamental a physical configuration of the watershed to be studied, such as a Digital Elevation Model (DEM), the topography digitalized, soils map, Land use map and information about the basin. Some hydrologic and hydraulic studies have been conducted by Sepulveda et al., [1996]; Rojas [2012]. 
[bookmark: _Ref399601477][bookmark: _Toc274202576]Table 3‑3. Drainage area peak discharge relationship [FEMA, 2012].
	Drainage Area (sq km) 
	Station Name
	Peak Discharge (cms)

	
	
	10%
	2 %
	1 %
	0.2 %

	467.73
	Rio Grande Añasco
 at Mouth
	1,809
	3,797
	5,130
	10,542

	347.33
	Rio Grande Añasco Near San Sebastian
	1,390
	3,031
	4,078
	8,329

	385.26
	Rio Grande Añasco upstream confluence Rio Casey
	1,527
	3,289
	4,432
	9,070

	414.88
	Rio Grande Añasco downstream confluence Rio Casey
	1,631
	3,481
	4,695
	9,624

	35.4
	Rio Yaguez 
at Mouth
	292
	595
	770
	1,289

	329.65
	Rio Guanajibo
at Mouth 
	1,352
	3,896
	5,745
	14,294

	310.53
	Rio Guanajibo
Near Hormigueros
	1,215
	3,637
	5,343
	13,196

	91.39
	Rio Guanajibo at Hwy 119 at San German
	604
	1,325
	1,713
	2,991

	303.04
	Rio Guanajibo downstream confluence Rio Rosario
	1,206
	3,507
	5,137
	12,620



The following sections present the analysis of each variable in the hydrological model and determining the best parameters for a good operation. The analysis was based on existing literature within the study area.




[bookmark: _Toc395981774][bookmark: _Toc274203630]CHAPTER - RESULTS 
This chapter present the results of this research since obtaining, handling and processing data radar as well as the development of nowcasting model, validation of results, comparison between TropiNet radar and NEXRAD radar, configuration of  hydrological model, implementations of nowcasting results and observed data into the hydrological model, configuration of inundation model, implementation of observed data and estimated data from hydrological model to inundation Analysis extension and finally comparison between USGS station and stations in the hydrological model.  

[bookmark: _Toc274203631]Data Acquisition


Numerous storms were analyzed during 2012 and 2014 to select the suitable storms to be forecast, some requirements to choose the storm were necessaries: the data should be constant without interruptions, the radar should have the same elevation angle for all storms, the data may not be altered, and the radar should not stop during the storm or change its positions. 

The TropiNet data was accessed from weather.uprm.edu server, the data is raw data in binary format. Two types of transformations from binary to net-cdf were needed to handle data and from net-cdf to mat, these transformations required the development of subroutines in MatLab. Other transformations necessary included changing the polar coordinates to Cartesian coordinates; this was done to handle the data in the hydrological model Vflo.

[bookmark: _Toc274203632]Rain gauges-TropiNet – NEXRAD comparison


A routine was implemented to compare between Rain Gauges, TropiNet and NEXRAD data. The NEXRAD pixels have 1 square kilometer area and the TropiNet pixels have 60 meter for each side, this means that 256 TropiNet pixels equivalent in size to one (1) NEXRAD pixel or within one NEXRAD pixel fit 256 TropiNet pixels. Two comparison types were done, the first was pixel to pixel, and the second was average TropiNet pixels (256) with one NEXRAD pixel. 

Figure 4‑1 presents a comparison image on a specific minute between TropiNet and NEXRAD, and shows the same storm but superimposed with the TropiNet image with the NEXRAD. This assignment was made for all storms analyzed to verify the storms location and confirm that the comparison data rain-rate is successful.
[image: C:\Users\Eric Harmsen\AppData\Local\Microsoft\Windows\Temporary Internet Files\Content.Word\Compare_Reflectivity_2014_05_06_17_42.png]
[bookmark: _Ref399610384][bookmark: _Toc274203244]Figure 4‑1. Comparison TropiNet and NEXRAD on May 06, 2014- 17:42.


Figure 4‑2 shows the comparison between NEXRAD and TropiNet at station C1, event May 21, 2014, the difference here is the average pixels (256) in TropiNet to change the resolution similar to NEXRAD. 
[image: ]
[bookmark: _Ref399610665][bookmark: _Toc274203245]Figure 4‑2 . Comparison Rain Gauge-NEXRAD-Average 
TropiNet –C1-May 21, 2014.

It includes the statistic results where MSE is the mean squared errors between Rain gauge-TropiNet and Rain gauges-NEXRAD and RMSE is the root means squared errors. The error is greater when the comparison between rain gauge and NEXRAD data is present, likewise the best result was observed between rain gauge and TropiNet data radar when it has the original resolution (60 meters).  


	
	
	(4‑1)




SSE is the sum-squared errors, the subscript  refers to TropiNet and subscript  refers to NEXRAD.

	
	
	(4‑2)

	
	
	

	
	
	(4‑3)




MSE is the mean square errors in TropiNet () and NEXRAD (), and the next equation is the roots mean squared errors RMSE with the same subscript as the last equations. 

Other comparisons were done with different dates between 2012 and 2014. Unfortunately, 20 (twenty) rain gauges were used and only few captured good data. In most rain gauges alterations were found to the equipment due to the natural or human factors. 
[bookmark: _Toc274203633]Nowcasting Model Movement and Reflectivity Analysis 


There are many methods to forecasting with long lead-time as: 8, 24, and 36 hours or weekly, using autoregressive methods, moving averages and others. This is a special kind of method to nowcasting (short time as minutes). In the Puerto Rico western area occur sudden precipitations with short durations due to atmospheric conditions and locations, the precipitations take place immediately and its durations is around 1, 2 or 3 hours. 
This shows the cloud motion comparison between observed (right) movement and estimated (left) movement at storm date March 28, 2012, 17:10 hours. Where the point black is the centroid at initial time and the red point is the centroid at the final time. In some cases there is more than one centroid and it can present more than one black and red point.  This happens when the division cloud method occurs.

The current radar reflectivity is a function of the previous reflectivity images observed in surrounding areas centered on the location of a predicted pixel, and also is a function of the ratio of reflectivity of a pixel to reflectivity of the cell convective core. 
The second postulated rainfall nowcasting algorithm task is predicting rainfall rate at each pixel.

[bookmark: _Toc274203634]Parameters Estimation


This methodology was applied to four (4) parameter unknowns  to find the optimum values with a bounded constraint, first linearized the main equation, second identify the initial point trough a nonlinear regression model where the phi  is temporarily ignored and the deltas values initial are obtained by solving the linear regression, third find the optimum values using a constrained nonlinear optimization technique to estimate the final parameter set for each zone (9x9) and every window where the phi  parameter is a bias correction factor introduced in the optimization.
The optimum parameters for the nonlinear regression model were estimated by solving a constrained nonlinear optimization problem (fmincon).  
Figure 4‑3 is the median of the value phi for lead-time 20 minutes.

[image: ]
[bookmark: _Ref273358035][bookmark: _Toc274203246]Figure 4‑3. Phi median, storm date: March 28, 2012, lead-time of 20 min.
 Figure 4‑4 presents the distribution of initial variable phi  and the optimal value for a lead-time of 30 minutes. 
[image: ]
[bookmark: _Ref273358071][bookmark: _Toc274203247]Figure 4‑4. Distribution of initial value of phi (left) and the optimal values of phi (right) for the storm date: March 28, 2012,for a lead-time of 30 min.

[bookmark: _Ref399616855][bookmark: _Toc274202577]Table 4‑1. Detection results for ten storms with lead-time of 10 minutes.
	Detection Results

	Skill Score
	                                                                                  Forecast

	Dates
	20120328
	20120329
	20120430
	20121010
	20140212
	20140629
	20140705
	20140506
	20140630
	20140521

	HR
	0.8774111
	0.963596
	0.9141715
	0.8068047
	0.9003213
	0.9487279
	0.8455507
	0.9385759
	0.8697176
	0.9141775

	POD
	0.7123848
	0.6272294
	0.6391765
	0.63715
	0.5290473
	0.6197455
	0.6070954
	0.4439358
	0.6297536
	0.5509015

	FAR
	0.2068765
	0.3348994
	0.294561
	0.2857665
	0.3400653
	0.3121831
	0.2686225
	0.3931983
	0.212944
	0.3158428

	Detection Bias
	0.8982017
	0.9430594
	0.9060692
	0.8920752
	0.8016661
	0.9010326
	0.8300713
	0.7315994
	0.8001382
	0.8052266

	PI
	0.7943065
	0.7519754
	0.752929
	0.7193961
	0.6964345
	0.7520967
	0.7280079
	0.6631045
	0.7621758
	0.716412






[bookmark: _Ref399616864][bookmark: _Toc274202578]Table 4‑2. Detection results for ten storms with lead-time of 20 minutes.
	Detection Results

	Skill Score
	                                                                                  Forecast

	Dates
	20120328
	20120329
	20120430
	20121010
	20140212
	20140629
	20140705
	20140506
	20140630
	20140521

	HR
	0.829492
	0.9586175
	0.8965384
	0.7430307
	0.8648185
	0.9154759
	0.7814875
	0.9160943
	0.8124894
	0.8905689

	POD
	0.6080734
	0.4684846
	0.5183947
	0.5362466
	0.3889142
	0.4556096
	0.5024324
	0.2493413
	0.5423473
	0.4380003

	FAR
	0.2816578
	0.4893022
	0.4345089
	0.3649257
	0.4751152
	0.465673
	0.4089899
	0.6057553
	0.3278306
	0.4179181

	Detection Bias
	0.8464955
	0.9173422
	0.9167159
	0.8443841
	0.7409516
	0.8526793
	0.8501248
	0.6324532
	0.8068611
	0.7524721

	PI
	0.7186359
	0.6459333
	0.6601414
	0.6381172
	0.5928725
	0.6351375
	0.6249767
	0.5198934
	0.6756687
	0.6368837





[bookmark: _Toc274203635]CHAPTER - CONCLUSION 
Here you summarize all the important contributions of your work. Bla blab la
 The rms difference between modeled and measured TB was reduced by 32%, from 1.56 K to 1.06 K, with the new parameters. Sensitivity analysis shows that the standard deviations on the CL, CW, CX parameters are 5% or less, and 8% for CC assuming 0.5K noise in the TB data. Correlation analysis between coefficients shows a high correlation between the errors in oxygen and the continuum terms.

The rms difference between modeled and measured TB was reduced by 32%, from 1.56 K to 1.06 K, with the new parameters. Sensitivity analysis shows that the standard deviations on the CL, CW, CX parameters are 5% or less, and 8% for CC assuming 0.5K noise in the TB data. Correlation analysis between coefficients shows a high correlation between the errors in oxygen and the continuum terms. Bla bla bla
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